
 
 

 

 

 

 

 

 

 

 

 

TFT LCD Module Tool Manual 

 

 

 

 

 

 

 

 

Specification No:  DS-1973-0000-01 

 

Date of Issue:  March 18, 2016  (00) 

 

Revision:  June 13, 2016  (01) 

    

    

    

Published by 

NORITAKE ITRON Corp. / Japan 

http://www.noritake-itron.jp 

 

This specification is subject to change without prior notice. 

 



TFT LCD Module Tool Manual 

- 1 - 

Contents 
1 Outline ............................................................................................................................................... 2 

1.1 Summary ............................................................................................................................................ 2 
2 Operating Environment.................................................................................................................... 2 

2.1 Supported Operating Systems ........................................................................................................... 2 
2.2 File Composition ................................................................................................................................. 2 

3 Installation ......................................................................................................................................... 3 
4 Images Tab Working with Image Files ............................................................................................ 6 

4.1 Opening Image Files .......................................................................................................................... 6 
4.2 Removing All Loaded Images from the Loaded Images List .............................................................. 8 
4.3 Selecting Image Format ..................................................................................................................... 9 

4.3.1 Writing selected images file into TFT’s internal memory FROM2. ............................................. 9 
4.4 Selecting FROM2 Write Modes ........................................................................................................ 10 
4.5 Resizing and Repositioning Images .................................................................................................. 11 
4.6 Writing Image Files to FROM2 ......................................................................................................... 12 
4.7 Displaying Images Stored in FROM2 on a TFT Module................................................................... 14 
4.8 Saving Binary Images of FROM2 Content to a Binary File .............................................................. 14 
4.9 Flashing FROM2 Image File to TFT Module Internal Memory ......................................................... 14 
4.10 Saving Map Files .............................................................................................................................. 15 
4.11 Opening Map Files ........................................................................................................................... 16 

5 Text Tab: Composing an Image ..................................................................................................... 17 
6 Switch Editor Tab, Designing Touch Switches ............................................................................ 18 

6.1 Creating and Deleting Touch Switch ................................................................................................ 18 
6.2 Positioning the Touch Switch on a User Window ............................................................................. 18 
6.3 Changing the Appearance of a Touch Switch................................................................................... 18 
6.4 Assigning a Touch Switch “Touched” and “Untouched” State .......................................................... 19 
6.5 Assigning an Image Stored in FROM2 to a Switch .......................................................................... 19 
6.6 Exporting Switch Functionality to a Text File .................................................................................... 19 

Revision History ............................................................................................................................................ 20 



TFT LCD Module Tool Manual 

- 2 - 

1  Outline 
 

1.1 Summary 
 
The TFT Tool application provides an easy way to display images, define touch buttons, and prepare 
image sequences for the Noritake Itron GU-TFT display module. 
 
The application communicates with the GU-TFT module via the virtual COM port provided by the USB 

VCOM Driver (supplied and installed separately – refer to USB VCOM Driver Installation Manual). 

This document explains how to install and use the TFT Tool software. 

 

 

2 Operating Environment 
 

2.1 Supported Operating Systems 
 

The following operating systems are supported: 

 
 Windows 7/8 (32-bit/64-bit) 

 
 

2.2 File Composition 
The TFT Tool software is distributed as a single installer file: 

 
TFT_Tool_setup.msi 
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3 Installation 
 

Run the installer and follow the instructions.  The screenshots reproduced below show a typical 
install sequence.  
  
Note: Due to operating system and setting differences, screen display content may vary. 
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4 Images Tab Working with Image Files 
 

The "Images" tab is designed to let you do the following: 

 

 Open image files stored on your computer 

 Select the desired image format supported by the TFT module for each image 

 Scale an image and set its position on the user window 

 Preview an image on a TFT module 

 Write image files to a TFT module’s internal FROM2 memory 

 Save the binary data of an image file in a GU-TFT supported format on your computer 

 Save the binary images of the module’s internal memory to your local drive  

 Save Map files containing all the necessary information for the host to display images stored on TFT 

module internal memory 

 Flash a binary file stored on your local drive to the internal FROM2 memory of a TFT module 

 

4.1 Opening Image Files 
 

 
Figure 1: “Open Image Files” option 
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Figure 2: Select your desired images and click “Open”. 

 

Opened files will be loaded into the "Loaded Images" list on the left side. 

The active image will be highlighted in green and will be also displayed in the "Preview" window. 

If you have many opened images, you can scroll the list up and down using the mouse wheel. 
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4.2 Removing All Loaded Images from the Loaded Images List 
 

You can remove all images from the "Loaded Images" list by right-mouse clicking on any image within the 

list and selecting "Remove all loaded images" as shown in figure below: 
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4.3 Selecting Image Format 
 

GT800X480A-C903P supports many image formats you can select from. The default format is 16bit RGB, 

which is recommended when you want to process and display images quickly. 

 

If you plan to store and display the selected image in a format different than 16bit, you can do so by clicking 

on "Image Formats" drop-down list and selecting the desired format. See the figure below for an example. 

 

You can also change the format of selected image by right-mouse click within "Preview" window and 

selecting the desired format. 

 
 

4.3.1 Writing selected images file into TFT’s internal memory FROM2.  

Before attempting to write any data into FROM2, it is important to understand how the data is stored in 
internal memory. The smallest amount of data that can be written to internal memory is one byte; 
however the smallest area that can be erased is 128KB, or a block. If you attempt to write new data to 
a block that is not empty and contains data, the block will first be first erased, and then new data will be 
written to that location. There are two methods of writing to FROM2 supported by this tool, called 
Sequential Write and Bulk Write. 
 
The Sequential Write Method always attempts to write new image data aligned with a block boundary.  
This is not space efficient compared to subsequent writes, that aren't block aligned. Another method 
called Bulk Write removes the block alignment constraint and attempts to write new data right after the 
previous data ended. The figure below illustrates an attempt to write 4 image files using both methods. 

 
 
 
 
 
 
 
 
 
 
 
 
Please be aware that although Bulk Write Mode is space efficient, it also much more difficult to 
selectively erase image files stored in FROM2. For instance, if you attempt erase file No.2, you will be 
also erasing file No.3 because it is located on the same 128KB block of memory. 
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4.4 Selecting FROM2 Write Modes 
 
The default FROM2 write mode is Sequential Mode. If you wish to use Bulk Mode then you can do so 
by clicking on the "Tools" menu, select "Settings", and click on the "Bulk" radio button. The new 
selected Bulk Write Mode will be also displayed on the Status Bar at the bottom of the window. 
 
The Bulk Write Mode will also be automatically selected if you right-click on the "Loaded Image" list 
and select "Add All Images to FROM2". 
If you use this feature, make sure you have an empty "FROM2 Content" list when switching FROM2 
Write Mode.  
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4.5 Resizing and Repositioning Images 
 
There are two methods for changing the image size; you can use the text boxes located on the top of 
window next to the "Image Transformations" button or use the sliders seen after clicking on the 
"Image Transformations" button.  

 
 
If you use text boxes, you must click on the "Local Preview" button to see a preview of your new image 
settings. Using sliders is a preferred method as you get an instant preview in the "Preview" window as 
you move the sliders around. 

 
 

 
 



TFT LCD Module Tool Manual 

- 12 - 

4.6 Writing Image Files to FROM2 
 
In order to write images to FROM2, the TFT module must be connected to your computer and an 
adequate power supply must be applied to it. Please select the appropriate COM port number from the 
"Serial Port Selection" drop-down list. 
 
Before attempting to write any image file to the TFT module’s internal FROM2, please select the 
desired write method first. The default setting is the Sequential Write Method, but you can also select 
the Bulk Write Method from the "Tools" menu. 
 
In order to write a file to FROM2, please select a file from the "Loaded Images" list and click on the 
"Write to FROM2" button. Repeat this process until all desired images are stored in FROM2. 
 
If you wish to store an image at a specific location in FROM2, you can do so by entering the address in 
the "Start Address" text box. 
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If you have selected Bulk Write Mode, please first add images to the "FROM2 Content" list by clicking 
on the "Add to FROM2" button. Once you have finished adding images, please click on the "Bulk 
Write" button to write images to FROM2.  
 
Please do not disconnect the USB cable or power down the TFT module while the serial transmission 
is in progress.  
 
If you plan to display a short animation on the TFT module that requires a big number of image files to 
be written to FROM2 you can take advantage of a feature that allows you to add all the images from 
the "Loaded Images" list to "FROM2 Content". Please be aware that the images are added to the 
"FROM2 Content" list in the order seen in the "Loaded Images" list.  
 
This feature is accessible by right-mouse clicking on any image within the "Loaded Images" list and 
selecting “Add all Images to FROM2” 
 
This feature automatically sets Bulk Write mode. To store the images in FROM2, click on the "Bulk 
Write" button. 
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4.7 Displaying Images Stored in FROM2 on a TFT Module 
 
Once the serial transmission is completed and all the images are stored in FROM2, you can display 
them on a TFT module by selecting the image on the "FROM2 Content" list and clicking on the 
"Display (FROM2)" button. 
 
If you wish to remove all images from the “FROM2 Content” list, click on the "Start Over" button. 
All the images will be removed and the "Start Address" will be set to 0x00000000. 
 
 

4.8 Saving Binary Images of FROM2 Content to a Binary File 
 
You can store the content of the "FROM2 Content" list, which you may have just written to your TFT 
module to a binary file and save it on your local drive. You can use it later to copy the image files to 
another TFT module in one simple step. 
 
In order to save the content in FROM2 to a binary file, click on the "File" menu and select  
“Save FROM2 Image to File” as shown in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.9 Flashing FROM2 Image File to TFT Module Internal Memory 
 
You can copy the content of one FROM2 memory from one module to another by using a binary file 
stored on your local drive.  
 
In order to do this: 

1. Power the module on 

2. Connect the TFT module to your PC 

3. Select the appropriate COM port from the "Serial Port Selection" drop-down list 

4. Click on the "Tools" menu and select “Flash FROM2 Image File” as shown below and select the 

desired binary file  

 
 
Depending on the size of the binary file, the serial transmission can take up to several minutes. 
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4.10 Saving Map Files  
 
A Map file is a text file that stores all the necessary information for the host to communicate with a TFT 
module to display images stored in FROM2. 
 
In order to save FROM2 Content information to a MAP file, please click on the "File" menu and select 
“Save FROM2 Map File” as shown below. 

 
 
Sample contents of a Map file is shown below: 
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4.11 Opening Map Files  
 
A MAP file can also be used by the TFT Tool to extract all the necessary information to populate the 
"FROM2 Content" list. Once the list is updated from a MAP file you can quickly check and verify the 
contents of FROM2 memory by clicking on the “Display (FROM2)” button. 

 
 
To open a MAP file stored on your local drive, click on the File menu and select “Open FROM2 Map 
File”. 
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5 Text Tab: Composing an Image 
 

Using the "Text" tab you can “compose” an image by combining a background image with rendered text. 

 

Each text block can be put on its own separate layer for easy processing and editing. 

 
 

In order to obtain an image like the figure above: 

1. Compose a background image on the "Images" tab and click on the “Local Preview” button. 

2. Go to the "Text" tab. 

3. Import a background image by clicking on the “Import Image” button 

4. Add a text layer (Layer-1) and enter your desired text into the “Text Input” edit box 

5. Select a desired font family, font color, style, and font weight from the drop-down lists located in the 

"Font Settings" area 

6. Position the text using the "Text Position" sliders 

7. Add a second text layer, enter your desired text, and repeat steps 5 and 6 

 

The composed image can then be exported to the "Images" tab by clicking on the “Export Image” button. It 

will be added to the end of the "Loaded Images" list.  

 

Tip: To get a quick preview of the font family, color, size, etc. just click on the appropriate drop-down list and 

use the up and down arrows on your keyboard.  
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6 Switch Editor Tab, Designing Touch Switches 
 

The "Switch Editor" tab lets you do the following: 

 Create custom touch switches 

 Position switches on the User Window 

 Assign how a switch looks in its touched and untouched state 

 Assign a switch to an image stored in FROM2 

 Export switch functionality to a text file 

 

 

6.1 Creating and Deleting Touch Switch 
 

In order to create a custom touch switch, left click in the preview window. 

To delete a switch right click on a switch that you would like to remove. 

 

 

6.2 Positioning the Touch Switch on a User Window 
 

To change the position of a touch switch simply place your mouse cursor on the top of the switch in the 

"Preview" window, left click and drag the switch to the desired location. 

 

You can also reposition your touch switch by selecting it in the "Touch Switches" list and entering its XY 

coordinates into the “PositionX” and “PositionY” text boxes. 

 

 
 

 

6.3 Changing the Appearance of a Touch Switch 
 

To change the size of the switch, you can either input its size into the appropriate text boxes or drag the 

switch on its bottom and right boundaries. To change its color, select the desired color from the "Color" 

drop-down list. 
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6.4 Assigning a Touch Switch “Touched” and “Untouched” State 
 

To assign a particular look to a touch switch's “Touched” or “Untouched” state, first you must have some 

images inside the “FROM2 Content” list to choose from. Let’s assume that you want to have a custom touch 

switch to look white when untouched and red when touched. 

 

To do this, please follow these steps: 

1. Create a white touch switch in the "Preview" window. 

2. Click on the “Export to Images” button 

3. Write the switch image to FROM2 

4. Go back to the "Switch Editor" tab 

5. Make sure that the "Switch Assignment"  radio button set to “Untouched” 

6. Select an appropriate image from the "FROM2 Content" list 

7. Click on the "Assign Untouched" button 

8. Click on the white touch switch in the "Preview" window 

9. Change the switch's color to red 

10. Repeat steps 2-4 

11. Change the "Switch Assignment" radio button to “Touched” 

12. Select an appropriate image from "FROM2 Content" list 

13. Click on the “Assign Touched” button 

 

 

6.5 Assigning an Image Stored in FROM2 to a Switch 
 

To assign an image to a switch that can be displayed when a switch is touched, do the following: 

 

1. Select a switch you want to assign an image to 

2. Set “Switch Assignment” to “FROM2 Image” 

3. Select an image from the “FROM2 Content” list 

4. Click on the “Assign Image” button  

 

 

6.6 Exporting Switch Functionality to a Text File 
 

In order to export switch functionality to a text file, click on the “Save to File” button. 

 

The text file will contain all the necessary information for the host to define the created touch switches and 

how the switches appear when touched and untouched from FROM2. 
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Revision History 
Specification number Date Revision 

DS-1973-0000-00 Mar. 18, 2016 Initial Issue 

DS-1973-0000-01 Jun. 13, 2016 Clarification of explanation 
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